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About This Guide

This guide is designed to be used as step-by-step instructions for installation
and as a reference for operation, troubleshooting, and future upgrades.

Text Conventions
This document uses the following conventions to distinguish elements of text:

Keys Keys appear in boldface. A plus sign (+) between
two keys indicates that they should be pressed
simultaneously.

USER INPUT User input appears in a different typeface and in
uppercase.

FILENAMES File names appear in uppercase italics.

Menu Options,
Command Names,
Dialog Box Names

These elements appear in initial capital letters.

COMMANDS,
DIRECTORY NAMES,
and DRIVE NAMES

These elements appear in uppercase.

Type When you are instructed to type information, type
the information without pressing the Enter key.

Enter When you are instructed to enter information, type
the information and then press the Enter key.
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Symbols in Text
These symbols may be found in the text of this guide. They have the following
meanings.

WARNING:  Text set off in this manner indicates that failure to follow directions

in the warning could result in bodily harm or loss of life.

CAUTION:  Text set off in this manner indicates that failure to follow directions

could result in damage to equipment or loss of information.

IMPORTANT:  Text set off in this manner presents clarifying information or specific

instructions.

NOTE:  Text set off in this manner presents commentary, sidelights, or interesting points

of information.

Getting Help
If you have a problem and have exhausted the information in this guide, you
can get further information and other help in the following locations.

Compaq Technical Support

You are entitled to free hardware technical telephone support for your product
for as long you own the product. A technical support specialist will help you
diagnose the problem or guide you to the next step in the warranty process.

In North America, call the Compaq Technical Phone Support Center at
1-800-OK-COMPAQ1. This service is available 24 hours a day, 7 days a week.

Outside North America, call the nearest Compaq Technical Support Phone
Center. Telephone numbers for world wide Technical Support Centers are
listed on the Compaq website. Access the Compaq website by logging on to
the Internet at http://www.compaq.com.

                                                          
1 For continuous quality improvement, calls may be recorded or monitored.
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Compaq Website

The Compaq website has information on this product as well as the latest
drivers and Flash ROM images. You can access the Compaq website by
logging on to the Internet at http://www.compaq.com./storage

Compaq Authorized Reseller

For the name of your nearest Compaq Authorized Reseller:

■  In the United States, call 1-800-345-1518.

■  In Canada, call 1-800-263-5868.

■  Elsewhere, see the Compaq website for locations and telephone
numbers.
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Chapter 1
Introduction

Welcome to the Tape Storage Management Console (TSMC).

This product is offered to both Compaq customers and trained service
personnel. The diagnostics, tests and tools that make up TSMC are designed to
aid in the installation and continued use of Compaq tape and tape automation
products.

The tool searches for and reports problems and failures with tape and tape
automation products connected via Fibre Channel, SCSI, or serial interfaces.
This is primarily accomplished through the use of Standard and Custom tests
that are built into TSMC. These tests emulate No Trouble Found (NTF) tests
developed by Compaq. If you are installing a device for the first time, you can
run TSMC to verify that the tape drive or tape library you purchased is
properly installed and is available to your system before you attempt to load
any other application software.

In addition, you can load firmware into tape drives or tape libraries either
concurrently or individually with the TSMC tool. If you are connected to the
World Wide Web, TSMC will search the appropriate Compaq website for the
latest available firmware needed by your device. Newer versions of TSMC are
also delivered to you over the Web.

IMPORTANT:  When using TSMC, be sure that you are in offline mode and that no other
applications are issuing tape commands to your devices.
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Assumptions about the Reader
This manual assumes that you have a working knowledge of Microsoft
Windows NT 4.0 and/or Microsoft Windows 2000. You should also have a
basic knowledge of the terms employed in describing and using the SCSI
interface and the application of SCSI devices. These are suggested levels and
not absolute requirements. TSMC is a flexible tool and can be used equally
well by both the novice and the expert.

Figure 1-1.  TSMC window after launch

Advanced and Basic Mode Testing
TSMC starts up in Basic Mode. This enables the Device Scan, a Device
Inquiry, and the ability to run Standard or Custom device tests. You can
operate in Advanced Mode for additional testing, which gives you access to
specific SCSI commands.

CAUTION:  Do not use data tapes when performing TSMC tests. Data tapes are
over written when performing TSMC tests. Use only Compaq-supplied testing
tapes, which have TST000-999 barcode labels.
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SCSI Requirements
This section discusses SCSI concepts you need to understand for a successful
installation of TSMC.

Every SCSI system bus requires that you:

 1. Have a host bus adapter (HBA) or initiator and target device.

 2. Connect the HBA or initiator and target device with cabling, or daisy
chain a string of target devices together to the initiator.

 3. Terminate devices at both ends, either at the device/adapter or by adding
an inline/external terminator.

SCSI ID

Your devices are displayed by TSMC in the Device Tree window, as shown in
Figure 1-2.

Figure 1-2.  SCSI information displayed in Device Listing

Icons indicate if the device is a tape drive, tape library, or fibre device. Next to
each icon, TSMC displays the corresponding SCSI Bus, ID, and LUN in order
in the brackets before each device name.
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Device Listing Icons

Table 1-1
Device Listing Icons

Icon Description

Hard Disk

CD-ROM or Optical Device

Tape Device

Bridge

Tape Automation (also called Jukebox or Library)

Fibre Products

The following devices are supported in the Compaq Storage Area Network
(SAN).

■  Fibre-supported Devices

■  8 and 12 port hub

■  Switch

■  Fibre to SCSI Bridge (for attaching fibre to SCSI tape libraries)

Figure 1-3.  Example of fibre bridge in device listing
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Either a Fibre-supported device, Fibre Switch, Fibre Hub, and/or Fibre Bridge
will be attached to the bus.

NOTE:  Fibre Hubs are not identified on the Bus.

Fibre Bridge

With a Fibre Bridge, a SCSI device is attached to the SCSI connections on the
bridge. The Bridge appears as one device, regardless of the number of SCSI
buses internal to it.
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Chapter 2
Installation

System Requirements
The following are the system requirements for TSMC:

■  Any Intel-based Compaq server that supports:

! Microsoft Windows NT 4.0 with Service Pack 4 or greater

! Microsoft Windows 2000 Professional, Server, and Advanced Server

■  Any Compaq fast-wide SCSI 2 host adapter or Low Voltage Differential
(LVD) with the driver CPQ32FS2.SYS (available on the Compaq
SmartStart CD-ROM) installed

NOTE:  Support is constantly being updated. Check the Compaq website for the latest
information on supported adapters.

■  Compaq Fibre Channel Host Bus Adapter with the driver
CPQFCALM.SYS (available on the Compaq SmartStart CD-ROM)
installed

■  A Web browser to view HTML Help files

TSMC assumes you are only using Compaq tape drive or tape automation
products.

CAUTION:  Using unqualified 3rd party host adapters that are not certified may
cause problems with firmware downloads.
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Internet Access

Internet access allows for program updates and access to firmware files.
Without Internet access you will need to copy files from a network server or
media.

Installing TSMC Software
The following sequence should be performed when installing your TSMC
software for the first time.

IMPORTANT:  Before continuing, exit any Windows programs.

 1. Insert your TSMC CD-ROM into the CD-ROM drive.

 2. If the Install program does not automatically start up, locate the file
SETUP.EXE on your CD-ROM, then double-click on it to start
installation.

 3. After the program has been initialized a Welcome screen appears.
Click Next.

 4. The TSMC license agreement appears:

! Click Accept if you agree to the terms. The Install Folder screen
appears.

! Click Decline if you do not agree to the terms. The installation
aborts.

 5. The Install Folder screen allows you to choose where to install TSMC.
The default is C:\PROGRAM FILES\COMPAQ TSMC. Click Next to
continue, or Browse to install TSMC in a different directory.

 6. The Shortcut Folder screen creates shortcut icons in the default folder,
or you can type a new name or select from an existing folder. After
selecting a Shortcut folder, click Next.

 7. Setup now has enough information to start installing TSMC.

 a. To make changes, click Back on the Ready to Install screen.

 b. To abort now or during install, click Cancel.

 c. To continue, click Install.

 8. After clicking Install, the Installing Files screen shows the progress of
setup.
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 9. After all of the files have been copied, the Finished Screen is displayed.
Click Finish to allow Setup to examine your system’s Advanced SCSI
Programming Interface (ASPI Layer).

 10. If your ASPI components are not up to date, the ASPI Layer Check
screen appears and Setup recommends installation of newer ASPI
components. Click Yes to install them.

 If your ASPI components are up to date, Setup tells you so. Click OK.

 11. Setup is complete. You must reboot your system for changes to take
effect. Click Yes to reboot your system before running TSMC.

CAUTION:  When using TSMC, be sure that you are in offline mode and that no
other applications are issuing tape commands to your devices.
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Chapter 3
Screen Layout

Startup
Double-clicking the TSMC icon executes the program.

CAUTION:  When using TSMC, be sure that you are in offline mode and that no
other applications are issuing tape commands to your devices.

Device Scan

After TSMC is launched, a screen briefly appears as TSMC scans all the SCSI
and Fibre buses on your system.

Figure 3-1.  Device scan
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These buses and devices are then displayed in a device tree. The display shows
all devices attached to the buses, even if these devices are not supported
by TSMC.

NOTE:  Initial scans on Windows 2000 may take up to 30 seconds

Device Listing

When scanning is complete, the Device Listing screen appears, showing each
SCSI or Fibre device. The number of SCSI devices on a Bus can range from 0
to 7, or 0 to 15 with Wide SCSI. Fibre devices can be directly attached or as
part of a switch network, therefore the numbers get much larger.

Figure 3-2.  Device Listing

NOTE:  Drives in jukeboxes are displayed in association with the libraries in which they
reside. Some drives may display incorrectly if the library is in standby mode or if a drive is
unavailable and the user has not reconfigured the library. To ensure correct display, place
the library online or reconfigure the library as needed.

Device Description

Icons indicate if the device is a tape drive, tape library, or fibre device. Next to
each icon, TSMC displays the corresponding SCSI Bus, ID, and LUN in order
in the brackets before each device name.
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Selecting a Device to Work On

Use your mouse to click on a tape device in the Device Listing. This opens the
device qualifier screen for the selected device.

Qualifier Screens
All SCSI diagnostic commands are executed from the Device Qualifier
screens. The appropriate screen is automatically selected when you click on a
device listing. For example, in testing DLT based libraries you would test the
individual DLT drive with a Sequential Qualifier screen or test your jukebox
with the Tape Automation Qualifier screen. Open the Qualifier screens by
clicking on a device in the Device Listing screen.

Sequential Qualifier Screen

Figure 3-3 shows the Sequential Qualifier screen in Basic Mode.

Figure 3-3.  Sequential Qualifier screen (Basic Mode)
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Figure 3-4 shows the Advanced Mode, with advanced functions displayed in
addition to the Basic Mode tests.

Figure 3-4.  Sequential Qualifier screen (Advanced Mode)

Tape Automation Qualifier Screen

This screen appears for testing Libraries and Autochangers. Basic and
Advanced Modes are shown in figures 3-5 and 3-6, respectively.

Figure 3-5.  Tape Automation Qualifier screen (Basic Mode)
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Figure 3-6.  Tape Automation Qualifier screen (Advanced Mode)

Message Logs
Error Logs
SCSI Logs

Robotic commands
in Tape Automation
(Advanced Mode)

Evokes a complete
barcode scan of
tape inventory on
supported libraries
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Chapter 4
Menu and Toolbar Commands

Menu Options
TSMC uses common menu commands, such as File, Print, and Exit. The Menu
Bar is located in the upper left hand corner of the TSMC screen. The Edit and
Window options will appear when a device is selected.

File Menu
The File menu options are described in the following table.

Table 4-1
File Menu

Menu Item Function

Force Serial
Download

If a download (see Chapter 5, Commands) fails, your
device might not respond to any commands. As a result,
it will not appear in the device listing. This command
allows you to force a serial download, thereby
recovering a device that would otherwise be unusable.

continued
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Table 4-1
File Menu continued

Menu Item Function

Force Rescan Initializes all attached SCSI buses and discovers any
devices on them. It also updates the Windows NT or
Windows 2000 device list, even if the devices were not
attached on boot.

You can also access the Force Rescan
function by clicking the Rescan icon located
on the toolbar.

Close Closes the topmost tool window. You must abort or
cancel all running or pending tests before closing a
window.

Export Log Allows you to export the selected log to a file. The
exported file is in plain text (ASCII) format.

Print Prints the selected log.
Print Setup Displays the standard print setup dialog, allowing you to

select or configure a printer.
Exit Closes the application. You must abort or cancel all

running or pending tests before closing the application
window.

Edit Menu
The Edit menu options are described in the following table.

Table 4-2
Edit Menu

Menu Item Function

Undo Undoes the last typing action. You cannot 'undo' a test
that you ran. This function exists so that you can undo a
change you made to a particular test parameter in the
tool windows.

Cut Removes the highlighted information from its current
location; allows paste elsewhere.

Copy Keeps highlighted information in its current location;
allows paste elsewhere.

Paste Places cut or copied information at the current pointer
location.
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View
The View menu options are described in the following table.

Table 4-3
View Menu

Menu Item Function

Device Listing Displays or hides the list of devices detected by TSMC.

You can also access the Display/Hide Device
Listing function by clicking the Show/Hide
icon located on the toolbar.

Toolbar Displays or hides the toolbar.
Status Bar Displays or hides the Status Bar, the part of the

application window that shows the current state of the
application.

Options Sets behavior and display characteristics of TSMC using
the option tabs shown in figures 4-1 through 4-5.
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Options Screen

From the Options screen, you can set behavior and display characteristics of
TSMC using the option tabs shown in figures 4-1 through 4-5.

Figure 4-1.  Display Settings tab

Desired throughput units for all subsequent tests that display rate information
are selected from the Display Settings tab, as shown in Figure 4-1.
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Figure 4-2.  Mode tab

Select Advanced or Basic as the default startup mode for all tool windows
opened, as shown in Figure 4-2.

NOTE:  Changing this option does not affect tool windows already opened.

Figure 4-3.  Network tab

These options provide alternative connection paths if the default websites are
unavailable, as shown in Figure 4-3.

IMPORTANT:  Use this option only if directed by Compaq support personnel.
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Figure 4-4.  Serial tab

If you have tape libraries that support firmware updates via serial ports, you
can set the serial port to use, as shown in Figure 4-4.

Figure 4-5.  Simulator tab

IMPORTANT:  Use this option only if directed by Compaq support personnel.
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Window Menu
The Window menu options are described in the following table.

Table 4-4
Window Menu

Menu Item Function

Cascade Places the first tool window in the upper left corner of
the application's client area (where the Compaq logo is
located). All subsequent windows are placed
progressively down and to the right from that first
window.

Tile Displays all open tool windows, splitting available client
area space equally among the windows.

Arrange Icons Organizes all minimized tool windows in the client area.

Help Menu
The Help menu options are described in the following table.

Table 4-5
Help Menu

Menu Item Function

Help Topics Shows topics for which help is available.
Update
Software

Retrieves the latest versions of the application and
database from the Internet, then opens the database to
show you any available updates. See Figure 4-6.

Visit Web Site Launches your default browser and connects to
Compaq's web site.

About TSMC Displays application copyright and version information.
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Update Software

Select a version to download and click Retrieve.

Figure 4-6.  Firmware Retrieval screen

After clicking Retrieve, TSMC displays a dialog that indicates download
progress. When the download is complete, the application asks you if you
want to start the installation of the new version. If you answer yes, make sure
that you close the running copy of TSMC before installing any new software.

You can also access the Update Software function by clicking on the Update
Software button on the toolbar when no device windows are open. When
device windows are open, this toolbar button becomes a shortcut to the
Download function. (See the section, “Firmware Download Utility,” in
Chapter 5.)
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Chapter 5
Commands

Basic and Advanced Functions
SCSI devices often need to be programmed, or setup to function properly for a
particular operating environment. Additionally, the media often needs to be
examined and perhaps formatted, partitioned, or otherwise prepared.

Testing devices and media can be accomplished with Basic Testing or with
Advanced Testing Mode. Advanced Mode allows for individual command
execution, along with the same Standard and Custom Tests as in Basic Mode.

Basic Mode Commands
The Basic Mode is comprised of a Standard Test and a Custom Test. These
tests are also available from the Advanced Mode screen.

NOTE:  See Chapter 6 for additional information on running the Standard and Custom
NTF tests.

Standard Test

The Standard Test examines various features of the tape device or library. The
time to perform this test varies depending on devices. See Chapter 6.
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Custom Test

The Custom Test examines features of the tape device in greater detail. The
time to perform this test will vary depending on devices. See Chapter 6.

Advanced Mode Commands
The Advanced Mode Commands are comprised of Basic, Info, Setup and
Motion Commands. The Motion Commands are only available on the Tape
Automation Qualifier screen.

Figure 5-1.  Advanced Mode commands available for a tape device or library

NOTE:  Some command buttons become disabled if no internal testing information is
available for the device.

Basic Commands
The Basic commands are Unit Ready, Reset, Eject, and Rewind. Most of these
commands are self explanatory, and are easy to execute by clicking the
appropriate button. Eject and Rewind may take several minutes to complete.

Info Commands
The Info commands are Inquiry, Log Sense, Mode Sense, and Request Sense.
These commands are used to provide operational and error information for
SCSI devices. By selecting these commands you can view available Log,
Mode, or Inquiry Pages and Page Contents. In addition, these pages are written
to the Message log, and can be saved to a file if needed.
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Inquiry

Figure 5-2.  Inquiry dialog

The Inquiry dialog, shown in Figure 5-2, displays detailed device parameters.
Click on a page in the left column to see its contents.

Log Sense

Figure 5-3.  Log Sense dialog

The Log Sense dialog, shown in Figure 5-3, displays current and historical
statistical information about the device. Click on a page in the left column to
see its contents.
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Mode Sense

Figure 5-4.  Mode Sense dialog

The Mode Sense dialog, shown in Figure 5-4, displays mode parameter pages
for the device. Click on a mode page in the left column to see its contents.

Request Sense

Figure 5-5.  Request Sense dialog.

The Request Sense dialog, shown in Figure 5-5, displays status information for
the device. The green traffic light indicates that the device is working
normally; a red traffic light indicates that something is wrong with the device.
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Setup Commands
The Setup commands are Erase and Download.

Erase

This command issues an erase to the device, which causes a sequential access
device, such as a tape drive, to be repositioned to the beginning of tape, and all
data “zeroed” out from the start to the logical end of tape. Note that the abort
function may not work; the device itself handles the erase command, and not
all devices can stop an erase once started.

CAUTION:  Use caution when running the Erase command The quick erase
writes a new Beginning of Tape (BOT) and completes in less than 30 seconds.
The long erase, once issued, cannot be aborted and runs to completion. The
drive reports "busy", and if you need to close TSMC and re-open it while an
erase is running, the bus can report back as busy and TSMC may not complete
its scan.

Downloading Firmware Updates

TSMC keeps track of all available firmware versions for specific Compaq
products.

TSMC has two options to get firmware or application updates from the Web.
You can use the Download command available in the TSMC program, or use
the FDU.EXE program located in the TSMC directory.

File Retrieval (FDU.exe)

FDU.EXE is a separate program that can be run from outside of TSMC. This
program can be run from any Microsoft Windows NT or Microsoft Windows
2000 system to get firmware or application updates. FDU.EXE can be found in
the parent directory of TSMC.

NOTE:  The FDU.EXE program appears in the Start Menu as File Retrieval.
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Download Command

After selecting the Download command, you are asked if you want to use the
firmware database. Click Yes if you want to use Compaq recommended
firmware updates. Click No if you have a specific firmware file that you want
to use.

If you clicked Yes, several dialogs appear and disappear. TSMC opens the
database and compares the list of available updates to the specific information
for your device. It then produces a list of firmware versions that you can use
for your device. That list is displayed in the Available Updates dialog shown
in Figure 5-6. If you have Internet access, the firmware file you select is
automatically downloaded. If you do not have Internet access, click on the Use
Local Media button and then click OK to browse for the firmware file from a
local source.

If no firmware versions are available for download, click Skip. TSMC will go
straight to the download dialog, where you can manually specify a file for
download.

Figure 5-6.  Selecting a firmware version in the Available Updates dialog

CAUTION:  Make your selection carefully -- firmware dictates the behavior of
your device, and different firmware versions will each make your device behave
differently.
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You will reach the download dialog, shown in Figure 5-7, if you answered No
to the 'use database' prompt or if you did not cancel the Available Updates
dialog. As the download dialog starts, it communicates with your device to
determine the optimal download parameters.

Before proceeding be sure to read the following cautions:

CAUTION:  Do not interrupt the download process or eliminate power to the
device while the download process is running. Doing so may render your device
unusable.

CAUTION:  ESL9000 and TL895 libraries use serial port downloads. Make sure a
serial cable is attached to the device and your host computer. If a download fails
to succeed, TSMC enforces a “forced re-download”. Follow the directions on
your screen to complete the procedure.

Figure 5-7.  Download dialog with no file selected.

IMPORTANT:  The default parameters, shown in Figure 5-7, might be the ones that TSMC
selects. You should not change these settings.

NOTE:  If selecting a firmware file from other than the Internet, it is recommended that
you put the file on a hard disk instead of reading it from a floppy.

Remember that TSMC determines download parameters for you when you
select a firmware file. If you must change download parameters, consult with
Compaq support personnel.
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Your tape device may need to be in a specific state to receive new firmware.
For example, the media may need to be ejected prior to the firmware
download. Check your tape device documentation for specific instructions.

After specifying a file or arriving to this dialog after using the firmware
database click on Download. Do not interrupt the download process or
eliminate power to the device while the download process is running. Doing so
may render your device unusable.

NOTE:  After firmware updates are made to devices, you should close and exit TSMC then
re-open it. This will properly update the device (library or drive) information, reflecting the
firmware update.

Motion Commands

The Motion Commands allow you to move cartridges and test the robotics of
your library. These commands include Home, Move Element, Position to
Element, and Clean Drive.

Home

This command resets the robotics arm to its starting point. Note that some
devices do not reposition their arm physically in response to this command.

Move Element

This command allows you to move cartridges from one location to another
within a library. You select a source tape, drive, or transport and then a
destination. You can also choose to repeat the move by choosing a repetition
value from the list.
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Figure 5-8.  Selecting a source and destination

In this case the tape labeled BUM651 will be moved from Slot 3 to Drive 0.
Both Source and Destination screens will be updated when the move is
complete.

Position to Element

This command moves the robotics arm to the slot address you specify.

Figure 5-9.  The Position to Element dialog

Clean Drive
Using the Clean Drive dialog, you specify a cleaning tape to use in a
particular drive. Note that the interface is identical to that of the Move
dialog. The cleaning mechanism of most tape drives involves moving a
cleaning tape to the drive. The drive then automatically cleans itself.

IMPORTANT:  Only use cleaning tapes that are distinguished with barcode labels.
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Figure 5-10.  The Clean Drive dialog

Inventory Commands
The Inventory commands are Find, Inventory, and Initialize.

Find
Selecting this command allows you to locate a specific tape in your library
by barcode. The search is case sensitive.

NOTE:  If you leave the field blank, Find takes you to the first cartridge.

Inventory

This command issues an inventory request from the tape library. The
information returned from the library to TSMC is from the last inventory
performed by the library. The following sections of the TSMC screen are
updated:

■  Bins

■  Import/Export (if applicable)

■  Drives

■  Transport (if applicable)
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Initialize

This command performs a forced inventory of tapes inside the library.
Barcodes are scanned and stored in memory.

NOTE:  This process can take along time depending on the size of your library of tapes.
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Chapter 6
Tools

Testing Tools
The Testing Tools and qualifiers are procedures suggested by Compaq to serve
as a vendor return test for a variety of tape drives. In addition, you can run the
tests to verify that the devices, libraries, and auto changers are properly
installed. There are two types of Tape Tests: Standard and Custom. These tests
can be run from the Basic or Advanced Modes.

The Standard and Custom tests on the tape drives run an Initialization, Buffer
Test, Write/Read Test, and a Filemark Test.

NOTE:  When running concurrent operations on Microsoft Windows NT or Microsoft
Windows 2000 systems, the multiple window displays do not update simultaneously, only
the last device opened shows the correct message log reporting when running a Custom
or Standard test. Once the last test completes, all messages update in order.

CAUTION:  Do not use data tapes when performing TSMC tests. Data tapes are
over written when performing TSMC tests. Use only Compaq-supplied testing
tapes, which have TST000-999 barcode labels.

CAUTION:  Depending on where you are in the test the ABORT command on
Extended and Standard library tests may force an application error on the next
command issued.
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Initialization

This test issues a test unit ready, standard inquiry, rewind tape, and reset log
pages. The Rewind Command causes a rewind of the tape to the physical
beginning of tape.

Buffer Test

This test issues Write Buffer /Read Buffer commands to the device

Write/Read Test

The Read test allows blocks of data to be viewed. Write allows you to write
data to any accessible byte and block on the drive.

CAUTION:  Any data written to a device overwrites the existing data, causing it
to be lost. Always make sure you have adequate backups.

Filemark Test

This test is used to separate data. It may also be used at the beginning of tape
to set the density of certain devices. These devices function by positioning to
the beginning of tape, and then detecting the density of the data in the block
following, and then automatically switching to the detected density.

The Space Command causes a tape device to space forward a specified
number of filemarks, thus allowing you to skip datasets and position the tape
exactly where you want it.
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Standard Test Procedure for Tape Drives

Testing times will vary, depending on the device.

Table 6-1
Standard Test for Tape Drives

Test Type Test performed

Initialization Issue a test unit ready command request

Issue standard inquiry commands

Issue Rewind Command

Save and reset log page parameters

Buffer Test Issue Write Buffer/Read Buffer

Write/Read Test Write/Read/Verify X blocks, with an increasing pattern with
compression on

Save and reset log pages

Write/ Read/Verify X blocks, with a decreasing pattern with
compression off

Save and reset the parameters of log pages

Reset all log pages

Read/Verify

Write/Read/Verify X blocks, with a random pattern with compression on

Save and reset the parameters of log pages

Reset all log pages

Filemark Test Issue a test unit ready command request

Issue Rewind Command

Issue a Filemark Command

Issue a Space Command to go back

Issue a Space Command to go ahead

Issue an Erase Command

continued
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Table 6-1
Standard Test for Tape Drives continued

Test Type Test performed

Partition Test (Helical
Scan Devices)

Add A Partition

Remove the Partition

Standard Test for Tape Libraries
The standard test procedure for libraries performs a series of moves from the
slots to drives and from drives to slots. The following moves are performed:

■  Move from a slot to a drive

■  Move from a drive to a slot

■  Move from a slot to the load port (libraries containing load ports)

■  Move from a load port to a slot (libraries containing load ports)
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Custom Test Procedures for Tape Drives
The Custom test runs an Initialization, Buffer Test, Write/Read Test, and a
Filemark Test. These tests are similar to the Standard tests, but implement the
tests more often, and in more locations. These times will vary, depending on
the device.

Figure 6-1.  Custom NTF with default selections

NOTE:  You can remove tests from the default settings, but you cannot add additional
tests.

Table 6-2
Custom Test for Tape Drives

Test Type Test performed

Initialization Issue a test unit ready command request

Issue a standard inquiry command request

Issue a standard inquiry command request

Buffer Test Issue a Write Buffer command

Issue Read Buffer command

continued
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Table 6-2
Custom Test for Tape Drives continued

Test Type Test performed

Filemark Test Issue a test unit ready command request

Issue Rewind Command

Issue a Filemark Command

Issue a Space Command to go back

Issue a Space command to go ahead

Issue an Erase command.

Issue a test unit ready command request

Issue Rewind Command

Issue Filemark Commands

Issue a Space Command to go back

Issue a Space command to go ahead

Issue an Erase command.

Issue a test unit ready command request

Issue Rewind Command

Issue Filemark Commands

Issue a Space Command to go back

Issue a Space command to go ahead

Reset all log pages

Save and reset the parameters of log pages

Write/Read Test Write/Read/Verify certain blocks with a random pattern with
compression on. Save the parameters of log pages. Reset all log
pages.

Write/Read/Verify certain blocks with a random pattern with
compression on. Save the parameters of log pages. Reset all log
pages.
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Extended Test Procedures for Libraries
The extended test procedure for libraries performs the same tests as the
standard test for libraries, but the moves performed are more extensive. The
moves listed below are performed:

■  Move from a slot to a drive

■  Move from a drive to a slot

■  Move from a slot to the load port (libraries containing load ports)

■  Move from a load port to a slot (libraries containing load ports)

Result Reporting
Test results are displayed in the Message Log, Error Log, and SCSI Log,
located at the bottom of the Advanced Qualifier screen.

Figure 6-2.  Selecting log on a tool window

Message Log

Figure 6-3.  Message log being updated during test

This log shows you every command executed so far in ascending order.
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Error Log

Figure 6-4.  Error log showing Device Not Ready response

This log shows you SCSI commands that failed or returned an error.

SCSI Log

Figure 6-5.   SCSI log showing several different CDB's being executed
sequentially

This log shows every SCSI command issued to the current device.
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Chapter 7
Frequently Asked Questions

How To...

Run a Request Sense Test

Follow these steps to determine if the device will report back an error:

 1. Make sure that you are in Advanced Mode.

 a. Select View, then Options from the menu.

 b. Select Advanced from the Tool Mode, then click OK.

 2. Click on a tape device in the device listing.

Figure 7-1.  Device tree listing
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 3. On the resulting Sequential Qualifier screen, click on the Request Sense
button.

 4. The Request Sense dialog will appear, indicating the status of the
device.

! A green traffic light indicates that the device is working normally.

! A red traffic light indicates that the device is not working normally.

Figure 7-2.  The Request Sense dialog

Look at Soft Error Rates

IMPORTANT:  Soft errors may indicate worn media or dirty tape heads.

Follow these steps to view the soft errors recorded by a drive.

NOTE:  These instructions are for DAT drives.

 1. Make sure that you are in Advanced Mode.

 2. Select the device you want to analyze.

 3. Select Log Sense from the resulting tool window.

 4. Select Drive Counters Log Page from Available Log Pages.

 5. In the Page Contents pane, look at the Offset, Parameters, Current Value
and Threshold Defaults for the error rates you are interested in.
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Figure 7-3.  Log Sense dialog displaying soft error rates

Update Your Firmware and Software

TSMC maintains a database of the most recent firmware versions for many
Compaq products. You can get the latest version database by clicking on
Update Software in the Help menu or by clicking on the Download toolbar
button with no device tool windows open.

IMPORTANT:  Be sure to keep your database version current.

To update your firmware, click on the Download button in the Advanced tool
windows or click on the Download button in the toolbar.

What If My Device Fails the Test?

If the tape device fails to pass a standard or custom test, you should perform
the following steps, if possible.

 1. Rerun the test.

 2. Replace the cartridge and rerun the test.

NOTE:  If the replacement cartridge is new, try a cartridge from a different batch. Compaq
recommends that you set aside a cartridge employed in any previously successful test as
a reference.
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 3. Clean the drive using a recommended cleaning cartridge. Rerun the test.

 4. Contact Compaq if the device still fails.

What if the Tests Fail to Complete?

If standard tests are not complete in 30 minutes or less, TSMC may have sent a
mode command, causing the device to run slowly. Look at the log to see if
there is activity. If activity is occurring very slowly, as in 1 event every couple
of seconds, abort the test.

What If I am Having Trouble Seeing Devices
on my SAN?

SAN environments can become unstable and TSMC may report back
erroneous results. Check and reset FIBRE to SCSI bridges if you suspect that
TSMC is having a problem with a device attached to a bridge.
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